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Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the 
Wi-Fi G Demo Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the Wi-Fi G Demo Board to create a Wi-Fi network 
and control the demo board functions from the client device web browser.

The manual layout is as follows:

• Chapter 1. “Overview” – This chapter provides a brief overview of the demo 
board, highlighting its features and uses.

• Chapter 2. “Hardware” – This chapter provides the hardware description of the 
Wi-Fi G Demo Board.

• Chapter 3. “Getting Started” – This chapter describes what you need to know to 
start using the Wi-Fi G Demo Board.

• Chapter 4. “Description of Modes of Operation” – This chapter provides the 
modes of operation description of the Wi-Fi G Demo Board.

• Chapter 5. “Programming” – This chapter describes what you need and how to 
program the Wi-Fi G Demo Board.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2013 Microchip Technology Inc. DS50002147A-page 7
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• Chapter 6. “Advanced Features” – This chapter describes the advanced fea-
tures such as changing transmit power.

• Chapter 7. “Customizing Web Pages” – This chapter provides the guidelines on 
how to customize web page contents.

• Appendix A. “Wi-Fi G Demo Board Schematic” – This appendix includes the 
Wi-Fi G Demo Board schematic.
DS50002147A-page 8  2013 Microchip Technology Inc.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}

 2013 Microchip Technology Inc. DS50002147A-page 9
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WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. Send-
ing in the Warranty Registration Card entitles users to receive new product updates. 
Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user's guide describes how to use the Wi-Fi G Demo Board. The following 
Microchip documents are available from the Microchip web site (www.microchip.com), 
and are recommended as supplemental resources.

MRF24WG0MA/MRF24WG0MB Data Sheet (DS70686)

Microchip MRF24W Getting Started Quick Guide for MRF24WB0MA/B, 
MRF24WG0MA/B for MLA v5 (DS52108)

PIC32MX5XX/6XX/7XX Family Data Sheet (DS61156)

TCPIP Stack Help.chm (This is bundled together with the TCIP/IP source code 
releases.)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives
DS50002147A-page 10  2013 Microchip Technology Inc.
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Preface
DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers 
and other language tools. These include all MPLAB C compilers; all MPLAB 
assemblers (including MPASM™ assembler); all MPLAB linkers (including 
MPLINK™ object linker); and all MPLAB librarians (including MPLIB™ object 
librarian).

• Emulators – The latest information on Microchip in-circuit emulators. This 
includes the MPLAB REAL ICE™ and MPLAB ICE 2000 in-circuit emulators.

• In-circuit Debuggers – The latest information on the Microchip in-circuit debug-
gers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit™ 3 debug 
express.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and 
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include 
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB 
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included 
are nonproduction development programmers such as PICSTART® Plus and 
PICkit 2 and 3.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: 
http://www.microchip.com/support

DOCUMENT REVISION HISTORY

Revision A (March 2013)

• Initial Release of this Document.
 2013 Microchip Technology Inc. DS50002147A-page 11
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Chapter 1.  Overview
1.1 INTRODUCTION

Thank you for purchasing the Microchip Technology’s Wi-Fi G Demonstration kit. The 
Wi-Fi G Demo Board provides a low-cost and portable development system for 
Microchip’s MRF24WG0MA IEEE 802.11b/g Wi-Fi Transceiver Module.

The Wi-Fi G Demo Board is preloaded with a demo software for the user to explore the 
features of the MRF24WG0MA Wi-Fi module. It is also expandable through an 8-pin 
expansion interface, which enables the user to extend its functionality by adding 
various sensor expansion boards.

The topics discussed in this chapter include:

• Wi-Fi G Demonstration Kit Contents

• Functionality and Features

1.2 Wi-Fi G DEMONSTRATION KIT CONTENTS

The Wi-Fi G Demonstration Kit contains the following:

• Wi-Fi G Demo Board

• 2 AAA Batteries

• Male 1x6 Connector Header HDR-2.54 (J14)

• Wi-Fi G Demo Board Information Sheet (DS52107A)

1.3 FUNCTIONALITY AND FEATURES

The Wi-Fi G Demo Board supports the following network types:

• Infrastructure (client)

• Ad hoc

• Wi-Fi Direct (peer-to-peer as group client)

• SoftAP

The security modes supported are:

• Open

• WEP-40, WEP-104 (Wired Equivalent Privacy)

• WPA (Wi-Fi Protected Access)

• WPA2 (Wi-Fi Protected Access)

For ease of setup and usability, the following connection methods are also supported.

• WPS-PBC (Wi-Fi Protected Setup Push Button Configuration)

• WPS-PIN (Wi-Fi Protected Setup Personal Information Number)
 2013 Microchip Technology Inc. DS50002147A-page 13
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A representation of the layout for the Wi-Fi G Demo Board is shown in Figure 1-1.

FIGURE 1-1: Wi-Fi® G DEMO BOARD LAYOUT

Note: For Demo Version 1.02, only SoftAP, infrastructure and ad hoc network 
support are offered. SoftAP supports only open and WEP security at this 
time. All security modes are supported in other network types. Future 
versions of the Demo software will include the additional functions noted 
above.
DS50002147A-page 14  2013 Microchip Technology Inc.



Overview
The Wi-Fi G Demo Board has the following key features:

1. MRF24WG0MA IEEE 802.11 b/g Wi-Fi Transceiver Module

2. PIC32MX695F512H 32-bit microcontroller

3. MCP1642 +3.3V Boost regulator

4. Three LED status indicators (LED0 - GREEN, LED1 - YELLOW, LED2 - RED)

5. One push-button switch for user input (SW0)

6. Power ON/OFF slider switch (S1)

7. 6-pin programming/debug port (J14)

8. 8-pin expansion port (J15)
 2013 Microchip Technology Inc. DS50002147A-page 15
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USER’S GUIDE

Chapter 2.  Hardware
This chapter describes the hardware features of the Wi-Fi G Demo Board.

2.1 HARDWARE FEATURES

The key features of the Wi-Fi G Demo Board are listed below and are introduced in 
Section 1.3 “Functionality and Features”. See Figure 1-1 for their locations on the 
board.

2.1.1 MRF24WG0MA IEEE 802.11 b/g Wi-Fi Transceiver Module

The MRF24WG0MA IEEE 802.11 b/g Wi-Fi Transceiver Module provides wireless con-
nectivity to the demo board. Host communication is through SPI2 of the PIC processor 
on the board.

2.1.2 Processor Support

The Wi-Fi G Demo Board is designed with a permanently mounted (soldered) 
PIC32MX695F512H processor.

2.1.3 Power Supply

The board is powered by 2 AAA batteries. If required, the battery voltage is monitored 
and boosted by the MCP1642 Synchronous Boost Regulator.

2.1.4 LEDs

The LEDs: LED0 (GREEN), LED1 (YELLOW) and LED2 (RED) are connected to 
PORTE and PORTF of the PIC32MX695F512H processor. To turn the LEDs ON, the 
port pins are set high.

2.1.5 Switches

The Wi-Fi G Demo Board has the following switches:

• S1 – Controls the main power to the board. To turn on the board, move S1 slider 
to the ON position.

• SW0 – It is an active low push-button switch, connected to RD9 of the processor. 
When idle, the switch is pulled high (+3.3V) and when pressed, it is grounded.

2.1.6 Programming/Debug Port

Connector J14 provides easy access to the PIC32MX695F512H processor’s debug 
pins. This is used to program or reflash the demo board with new firmware.

2.1.7 Expansion Port

Connector J15 provides access to six of the processor’s spare I/O pins. These pins can 
function as general purpose I/O ports or as an SPI, I2C or UART interface to an external 
circuit design.
 2013 Microchip Technology Inc. DS50002147A-page 17
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TABLE 2-1: J15 EXPANSION PORT PIN CONFIGURATIONS

Pin 1 Pin 2 Pin 3 Pin 4 Pin 5 Pin 6 Pin 7 Pin 8 Interface

SCK +3.3V GND SDI SDO /SS -* -* SPI

- +3.3V GND SDA SCL - -* -* I2C™

RTS +3.3V GND RX TX CTS -* -* USART

TX2

* - Pins 7 and 8 may be used as GPIO or A2D (analog-to-digital) pins.

+3.3V GND RX1 TX1 RX2 -* -* DUAL 
USART
013 Microchip Technology Inc. DS50002147A-page 18
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Chapter 3.  Getting Started
3.1 OVERVIEW

The Wi-Fi G Demo application uses a network provisioning mechanism called 
EasyConfig to enable configuration of an embedded device on a wireless network. 
EasyConfig utilizes the web server of the TCP/IP stack and a wireless network to 
enable the user to input the desired network information from a client browser, and then 
reset the device to connect to the desired network.

3.2 RUNNING THE Wi-Fi G DEMO APPLICATION

This section describes how to connect to the Wi-Fi G Demo Board to control the on 
board LEDs and view the status of the SW0 switch from a web browser. It also 
describes how to connect the Wi-Fi G Demo board to an existing network.

1. After turning the power on, the Wi-Fi G Demo Board broadcasts a SoftAP net-
work with an SSID, MCHP_G_xxxx, where, xxxx is the last four digits of the 
MRF24WG0MA IEEE 802.11 b/g Wi-Fi Transceiver Module’s MAC address (See 
Example 3-1).

EXAMPLE 3-1: 

FIGURE 3-1: AVAILABLE WIRELESS NETWORKS

MRF24WG0MA MAC (SN): 001EC001F102
SSID: MCHP_G_F102

Note: SoftAP is required to transmit beacons within each beacon interval. This 
increases the transmit power consumption and therefore shorten the 
battery life.
 2013 Microchip Technology Inc. DS50002147A-page 19
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2. Connect a client device (e.g., laptop, smart devices) to the MCHP_G_xxxx 
SoftAP network.

3. When the client device is connected, use a standard web browser and enter the 
IP address of the Wi-Fi G Demo Board. The default IP address is 
http://192.168.1.3. Another alternative is to enter “mchpboard.local” into the web 
browser. See figure Figure 3-2.

FIGURE 3-2: ACCESSING WEB BROWSER

4. The following web pages from the web server that is running on the Wi-Fi G 
Demo Board are displayed.

a) The index.htm web page displays the additional information about the Wi-Fi G 
Demo Board application. It also displays the continually updating status of the 
three LEDs (LED0, LED1 and LED2) and push-button on the Wi-Fi G Demo 
Board, see Figure 3-3. To control the LEDs, click on the LED icon on the web 
page. To see the status of the push-button, press SW0 on the Wi-Fi G Demo 
Board.
DS50002147A-page 20  2013 Microchip Technology Inc.
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Getting Started
FIGURE 3-3: SAMPLE INDEX.HTM WEB PAGE

b) The mrf24wg0ma.htm web page highlights the features of the MRF24WG0MA 
IEEE 802.11 b/g Wi-Fi Transceiver Module and the supporting development 
tools. See Figure 3-4.
 2013 Microchip Technology Inc. DS50002147A-page 21
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FIGURE 3-4: SAMPLE MRF24WG0MA.HTM WEB PAGE

c) The configure.htm web page enables the user to scan for nearby networks 
and connect to the selected network to start up as a group client in Wi-Fi Direct 
network, or as an ad hoc, or as a SoftAP and to select WPS-PBC or WPS-PIN. 
See Figure 3-5.
DS50002147A-page 22  2013 Microchip Technology Inc.
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FIGURE 3-5: SAMPLE CONFIGURE.HTM WEB PAGE

5.  To connect the Wi-Fi G Demo board to an existing network, click Display Scan 
Results on the configure.htm web page. See Figure 3-6.

FIGURE 3-6: DISPLAY SCAN RESULTS WEB PAGE

6. When a new network is selected, the Wi-Fi G Demo Board resets automatically 
using the parameters (SSID, security key) of the new network to reconnect to this 
new network. See Figure 3-7.
 2013 Microchip Technology Inc. DS50002147A-page 23
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FIGURE 3-7: RECONNECTION TO NEW NETWORK

7. To continue using the demo, the client device must be reconnected to the same 
network where Wi-Fi G Demo Board is redirected to.

Note: This is not applicable for initial release Demo Version 1.02. The demo board 
always attempts to connect to the last known network. If the user wants to 
reset the demo board to factory default conditions (startup in SoftAP mode) 
again, then simply press SW0 for 4 seconds. Do NOT press SW0 immedi-
ately on power up, as this initiates a self-test and does not reset the demo 
board to default factory conditions. 
DS50002147A-page 24  2013 Microchip Technology Inc.
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Chapter 4.  Description of Modes of Operation
4.1 SoftAP NETWORK

On starting the demo, the factory default conditions has the product start up as a 
SoftAP without security. This means that all the network information that is being con-
figured on the device is going over-the-air in the open. For most applications, unless 
another user is specifically attempting to listen in on this network, the potential security 
impact is minor. However, for applications that require baseline level of security, WEP 
can be employed on the network.

SoftAP is the centralized coordinator for the network. With MRF24WG0MA IEEE 
802.11 b/g Wi-Fi Transceiver Module firmware version 0x3107 and future releases, it 
supports Wired Equivalent Privacy (WEP) (40-bit/104-bit) security.

4.2 AD HOC NETWORKS

Ad Hoc networks are peer-to-peer networks with no centralized coordinator for the net-
work. All the devices share the responsibilities of keeping the network running. Accord-
ing to 802.11 specifications, ad hoc network only supports 802.11b rates of 1 Mbps, 2 
Mbps, 5.5 Mbps and 11 Mbps.

One downfall of ad hoc networks is that typically security is not employed on them.

The MRF24WG0MA IEEE 802.11 b/g Wi-Fi Transceiver Module can secure an ad hoc 
network with Wired Equivalent Privacy (WEP) (40-bit/104-bit) security, like most of the 
laptops and ad hoc devices. Very few devices in the market can secure an ad hoc net-
work with Wi-Fi Protected Access (WPA) level security due to tremendous overhead.

For most applications, unless another user is specifically attempting to listen in on this 
network, the potential security impact is minor. However, for applications that require 
baseline level of security, WEP can be employed on the network.

Most Android devices do not support ad hoc networks.

4.3 Wi-Fi DIRECT NETWORKS

Wi-Fi Direct network is a peer-to-peer (P2P) network. It enables the user to configure 
a secured wireless network between several devices, such as smart devices, laptops 
or computers with wireless network adapters, without using an access point (AP).

Wi-Fi Direct supports Wi-Fi Protected Setup (WPS) connection method, which is 
known as the WSC (Wi-Fi Simple Configuration) Config Methods in the Wi-Fi 
Peer-to-Peer (P2P) Technical Specifications, in particular WPS Push Button method 
with WPA2.

From the negotiation process, each device determines which devices become group 
owner (GO) or group client (GC). The GroupOwnerIntent field in the P2P information 
element (IE) indicates the level of desire to become the GO. The higher the value, the 
higher the desire to be the GO.

MRF24WG0MA IEEE 802.11 b/g Wi-Fi Transceiver Module only supports the role of 
GC.

Wi-Fi Direct does not support 802.11b.
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4.4 ZERO CONFIGURATION/BONJOUR

Zero Configuration (Zeroconf) provides a mechanism to simplify the device configura-
tion on a network. The term Zeroconf is titled from the names Bonjour (Apple) and 
Avahi (Linux), and is an Internet Engineering Task Force (IETF) standard. Zeroconf 
provides simplified naming conventions, instead of relying on the IP addresses alone.

The Zeroconf is built on the following three core technologies:

4.4.1 Link Local

The first component of Zeroconf is the ability to self-assign an IP address to each mem-
ber of a network. Usually, a Dynamic Host Configuration Protocol (DHCP) server han-
dles such situations. However, when no DHCP server exists, Zeroconf-enabled 
devices negotiate the unique IP address amongst themselves.

4.4.2 Multicast DNS

The second component of Zeroconf is the ability to self-assign the host names. Multi-
cast Domain Name System (mDNS) provides the local network with the ability to have 
the features of a DNS server. User can use the host names to access the devices on 
the network. When devices select to use the same host name, as in the IP address res-
olution, each of the devices has the ability to self-assign the Auto-negotiate New 
Names, usually appending a number at the end of the name.

4.4.3 Service Discovery

The last component of Zeroconf is service discovery. All Zeroconf devices can broad-
cast what services they provide. For instance, a printer can broadcast about available 
printing services. A thermostat can broadcast that it has an HVAC control service. For 
a specific service, the user can see the list of devices that provide the service, and 
connect to it. This eliminates the need to know whether something exists on a network 
(and what its IP or host name is). The user can query the network to see if a certain 
service exists or not, and easily connect to it.

4.4.4 Zero Configuration & mDNS demonstration

An iPhone and an apps supporting Zero Configuration is used in the demonstration.
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FIGURE 4-1: ZERO CONFIGURATION DOMAIN

Click on the local domain and determine available services. See Figure 4-2.

FIGURE 4-2: SERVICE DISCOVERY

Click on the service offered, in this case, DemoWebServer. A web browser opens and 
displays the Wi-Fi G Demo Board web pages. See Figure 4-3.
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FIGURE 4-3: DEMO WEB BROWSER

4.5 CONFIGURED VS. UNCONFIGURED STATE

When the Wi-Fi G Demo is in an unconfigured state (i.e, serving the default 
MCHP_G_xxxx SSID in SoftAP mode), the GREEN LED (LED0) blinks twice per sec-
ond to indicate that it is not configured. After the network is configured, the LED blinks 
once per second.

Note: When the Wi-Fi G Demo Board is moved to a different network, a new IP 
address is assigned to it. As the new Wi-Fi G Demo Board does not display 
the new IP address, the user must obtain the new IP address from the 
server that assigned it. Refer to your server’s documentation for the neces-
sary steps required to obtain the new IP address.
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4.6 DETERMINING NEW IP ADDRESS ASSIGNED

There are two methods to determine the new IP address assigned:

a) Zero Configuration / mDNS

From the zero configuration apps, once this apps redirects and opens up the web 
browser, the Wi-Fi G Demo web page shows the new assigned IP address. See 
Figure 4-3.

b) AP DHCP ClientTable

Refer to your AP’s documentation for the necessary steps required to obtain the new 
IP address. As an example, for certain APs, by selecting <Status> and then <Local Net-
work>, an option <DHCP Client Table> is offered. This DHCP Client Table lists the IP 
address that is assigned to the Wi-Fi G Demo Board. See Figure 4-4.

FIGURE 4-4:  DHCP CLIENT TABLE
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Chapter 5.  Programming
5.1 SOFTWARE

The required software to program Wi-Fi G Demo Board include:

• Microchip MPLAB® X IDE

• Microchip MPLAB XC32 Compiler

Wi-Fi G Demo Board is based on the Microchip TCPIP stack software. You can down-
load the latest software version from the Microchip web site, as this contains the latest 
bug fixes and the best support for current versions of the compilers.

Initial release is based on the Microchip TCPIP v5 stack software. Future plan is to add 
this to Microchip TCPIP V6 stack software. Software updates are available on the 
Microchip web site.

The initial release will only demo SoftAP with the capability to scan before connection, 
enabling scan results to be available. From the scan results, another network can be 
chosen to be redirected to.

Future releases will add more features such as Wi-Fi Protected Setup (WPS), etc.

Refer to the release notes for more information.

5.2 HARDWARE

The following hardware is required to program the Wi-Fi G Demo Board:

• In-circuit debuggers, emulators or programmers such as the PICkit™ 3, MPLAB 
ICD 3 and MPLAB REAL ICE™ In-Circuit emulator.

In Figure 5-1, the MPLAB ICD 3 is used.

In Figure 5-3, the PICkit 3 debugger is used.

• ICD 2 to ICSP Adaptor (Part number AC164110) is needed if the MPLAB ICD 3 or 
MPLAB REAL ICE In-Circuit Emulator is used.

• Wi-Fi G Demo Board

• Power supply requirements:

- If programming using PICkit 3 or MPLAB ICD 3, power supply can be supplied 
from the PICkit 3 or MPLAB ICD 3 itself.

- If using batteries during programming, note that multiple programming may 
drain the batteries.

- +3.3V DC power supply may be needed if MPLAB X IDE is in debugging 
mode.

The required hardware interconnections include:

• ICD 2 to ICSP Adaptor (Part number AC164110)

- Connect Wi-Fi G Demo Board J14 pin 1 to ICD 2 to ICSP Adaptor J2 pin1. 
See Figure 5-2.

• PICkit 3

- Connect Wi-Fi G Demo Board J14 pin 1 to PICKit3 header pin 1. See 
Figure 5-3.
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• If external power supply is used:

- Supply Wi-Fi G Demo Board J14 pin 2 with +3.3V.

- Connect Wi-Fi G Demo Board J14 pin 3 to GND.

Otherwise, make sure 2 AAA batteries are present.

FIGURE 5-1: Wi-Fi® G DEMO BOARD – MPLAB® ICD 3 HARDWARE 
INTERFACE

FIGURE 5-2: Wi-Fi® G DEMO BOARD – ICD 2 TO ICSP™ ADAPTOR 
HARDWARE INTERFACE
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FIGURE 5-3: Wi-Fi® G DEMO BOARD – PICkit™ 3 HARDWARE 
INTERFACE

5.3 PROGRAMMING SEQUENCES – PROJECT

1. Open MPLAB X IDE.

2. Click on File>Open Project. Browse to Wi-Fi G Demo Board directory and open 
Wi-Fi G Demo Board. See Figure 5-4.

FIGURE 5-4: OPEN Wi-Fi® G DEMO BOARD PROJECT

3. Check the appropriate in-circuit debugger is selected. Click on <Project Proper-
ties>. See Figure 5-5. Ensure that right in-circuit debugger is selected. See 
Figure 5-6.
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FIGURE 5-5: PROJECT PROPERTIES

FIGURE 5-6: IN-CIRCUIT DEBUGGER SELECTION

4. Ensure that power switch S1 is set to ON. Select <Make and Program Device 
(Project Wi-Fi_G_Demo_Board)>. See Figure 5-7.
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FIGURE 5-7: MAKE AND PROGRAM DEVICE

5. Wait for programming to complete. See Figure 5-8.

FIGURE 5-8: PROGRAMMING IS COMPLETED
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5.4 PROGRAMMING SEQUENCES – HEX FILE

1. Open MPLAB X IDE.

2. Click on File>Import>Hex/ELF ..(Prebuilt) File.

See Figure 5-9.

FIGURE 5-9: IMPORT HEX FILE

3. Browse to directory containing this HEX file. Select the correct device 
<PIC32MX695F512H>. See Figure 5-10.
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FIGURE 5-10: IMPORT HEX FILE – SELECT DEVICE PIC32MX695F512H

4. Select the correct hardware tool (in-circuit debugger), for example PICkit 3. See 
Figure 5-11.

FIGURE 5-11: IMPORT HEX FILE – SELECT IN-CIRCUIT DEBUGGER

5. A Summary listing the Project Directory, Target Device, Platform Tool and Project 
Source are displayed. Click on <Finish>. See Figure 5-12.
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FIGURE 5-12: IMPORT HEX FILE – COMPLETED

6. Power supply is supplied to Wi-Fi G Demo Board from the in-circuit debugger. 
Under <Project Properties> and selected in-circuit debugger, click on Option 
categories>Power. Enable option to <Power target circuit from PICkit 3> or 
<Power target circuit from MPLAB ICD 3>. See Figure 5-13 and Figure 5-14.

FIGURE 5-13: PICkit™ 3 POWER CONFIGURATION
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FIGURE 5-14: MPLAB® ICD 3 POWER CONFIGURATION

7. Click on <Make and Program Device>. See Figure 5-15.

FIGURE 5-15: MAKE AND PROGRAM DEVICE

8. Once programming is completed, the output panel displays programming com-
pleted status. See Figure 5-16.
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FIGURE 5-16: PROGRAMMING COMPLETED
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Chapter 6.  Advanced Features
6.1 CHANGE TRANSMIT POWER

Wi-Fi APIs are available in source file WFTxPower.c to read and write MRF24WG0MA 
transmit power. MRF24WG0MA has a transmit power range of 0 dBm to 18 dBm.

Invoke function prototype WF_TxPowerGetMax to read back MRF24WG0MA transmit 
power. Invoke function prototype WF_TxPowerSetMax to set MRF24WG0MA transmit 
power. No conversion of units is needed as input parameter to WF_TxPowerSetMax is 
in dBm.
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Chapter 7.  Customizing Web Pages
7.1 SOFTWARE REQUIREMENTS

• Microchip MPLAB X IDE

7.2 DIRECTORY LOCATION

WiFiGDemo web pages are contained within MPLAB WiFi_G_Demo_Board project.

FIGURE 7-1: Wi-Fi® G DEMO BOARD MPLAB® PROJECT DIRECTORY

• Execute or run batch file, based on MPFS utility MPFS2.jar, to compile HTM files 
into a WiFiGDemoMPFSImg.c image

\TCPIP\WiFiGDemo\Convert WebPages to MPFS.bat
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This batch file will output five files upon successful completion.

- WiFiGDemoMPSFSImg.bin
- WiFiGDemoMPFSImg.c (used by Wi-Fi_G_Demo_Board proj-

ect)

- WiFiGDemoMPFSImg.s
- HTTPPrint.c
- HTTPPrint.idx

• Wi-Fi G Demo HTM files

\TCPIP\WiFiGDemo\WiFiGDemoWebPages

Web Pages

• index.htm
• mrf24wg0ma.htm
• configure.htm
• error.htm
• reconnect.htm

• Javascript file

\TCPIP\WiFiGDemo\WebPages\javascript\mchp.js

• Source code files (where HTM files and stack source codes interacts)

\TCPIP\WiFiGDemo\customHTTPApp.c

7.3 STEPS FOR CUSTOMIZING WEB PAGE CONTENTS

This section illustrates customizing web page contents by adding a new field entry <RF 
module FW version> to index.htm.

1. Click on the selected HTM file to view the original un-modified web page. For 
example, index.htm. See Figure 7-2.

FIGURE 7-2: ORIGINAL UN-MODIFIED INDEX.HTM 

2. Open index.htm. Create a new entry by adding the following line: 
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<li>RF module FW version: <b> fwver~</b><li>

Save the file. See Figure 7-3.

FIGURE 7-3: INSERT NEW ENTRY INTO INDEX.HTM

3. Click on the modified index.htm to view the changes. See Figure 7-4.

FIGURE 7-4: MODIFIED INDEX.HTM 

4. For new added functions, such as <RF module FW version>, the corresponding 
files may need to be changed.
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• CustomHTTPApp.c
// ==========================================
// = Sends the FW version =
// ==========================================
void HTTPPrint_fwver(void)
{

static BOOL firstTime = TRUE;
static tWFDeviceInfo deviceInfo;
BYTE fwVerString[8];

if (firstTime)
{

firstTime = FALSE;
WF_GetDeviceInfo(&deviceInfo); // only call this once, not 
continually

}
uitoa((deviceInfo.romVersion << 8) | deviceInfo.patchVersion, 
fwVerString);
TCPPutString(sktHTTP, fwVerString);

}

5. Run the batch file <Convert WebPages to MPFS.bat> to generate a new 
WiFiGDemoMPFSImg.c image

6. Rebuild the project. In the build process, the project uses WiFiGDemoMPF-
SImg.c.

7. Connect to the WiFiG-Demo network. The changes are reflected on the 
WiFi-GDemo web page.

FIGURE 7-5: NEW Wi-Fi® G DEMO WEB PAGE
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Appendix A. Wi-Fi G Demo Board Schematic
A.1 INTRODUCTION

This appendix shows the Wi-Fi G Demo Board Schematic.
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